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1. System configuration 

The system configuration of TOP and “DONGDO TECH – ML Series” is as follows. 

 

Series Link I/F 
Communication 

method 
System setting Cable 

ML Series Serial Port RS-232C 

3. TOP 

communication 

setting 

4. External device 

setting 

5. Cable table 

 

 

 

■ Connection configuration 
 

ㆍ1:1 (one TOP and one external device) connection – configuration which is possible in RS232C communication. 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the display and process of TOP to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “OTHERS Manufacture”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

DONGDO TECH : ML Series Serial ML Protocol 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Serial] 

– Set the TOP communication interface in TOP Design Studio. 
 

 

 

 
 

Items TOP External device Remarks 

Signal Level 

(port) 
RS-232 RS-232  

Baud Rate 9600  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. (COM3 supports only RS-485.) 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Project > Project properties > PLC settings > COM1 > “PLC1 : DONGDO TECH : ML Series”] 

– Set the options of the communication driver of ML Series in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Serial”. Refer to “2. External 

device selection”. Protocol Select “ML Protocol”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device. *Note 1) 

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Retry  Set the number of retries in case of communication failure.  

POS1 Format Set the POS1 format configured in ML Series.  

POS2 Format Set the POS2 format configured in ML Series.  

Using Groups OK/NG Check when using Group OK/NG in ML Series.  

*Note 1)  Set it longer than ML Series의 [Probe Stable Time] + [Output Hold Time] of ML Series.
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP External device Remarks 

Signal Level 

(port) 

RS-232 
RS-232  

Baud Rate 9600  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. (COM3 supports only RS-485.) 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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(2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

  

 

Items Settings Remarks 

Interface Select “Serial”. Refer to “2. External 

device selection”. Protocol Select “ML Protocol”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device. *Note 1) 

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Retry  Set the number of retries in case of communication failure.  

POS1 Format Set the POS1 format configured in ML Series.  

POS2 Format Set the POS2 format configured in ML Series.  

Using Groups OK/NG Check when using Group OK/NG in ML Series.  

*Note 1)  Set it longer than ML Series의 [Probe Stable Time] + [Output Hold Time] of ML Series.
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check whether the port (COM1/COM2/COM3) settings you want to use are the same as those of the external device in [Control 

Panel > Serial]. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported address 

(For details, refer to the PLC 

manufacturer’s manual.) 

 

  



 

 

External device connection manual for TOP Design Studio 9 / 15 

4. Externaldevice setting 

Refer to the manufacturer’s user manual. 

This manual was written based on ML-CP. 

 

ML-CP menu screen 

 

 

(1) Group setting 

■  [Group] – [Group Use] 

 

 

 

- ON: Activated on the measurement screen 

- OFF: Deactivated on the measurement screen 

-  

There is a difference in Group Address according to ON/OFF settings. Remark Group Address 

 

 

(2) Start Method setting 

■  [Control] – [Start Method] 

 

- Set Start = Auto.  

 

It only supports the Start Method Auto mode.  
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(3) Serial setting 

■  [Control] – [Serial]  

 

 

 

Send = ON 

Speed = Serial communication speed to communicate with TOP 

Type = ASCII  Only supports ACSII> 

POS1, POS2 = Specifies items to be displayed. 

- Start Number = basic 01  

- OK/NG = Displays judgment value  

- Data Number = Number of data displayed on the screen  

- Model Number = Model1,2….  

- Model Name = Corresponding model name 

Items specified in POS1 and POS2 must be set identically to the TOP POS1 and POS2 settings. 

 

Data Format 

- Point = Use of decimal point  

- Preset = Preset input value display  

- Int.Length = Digits of the integral number  

- Group OK/NG = Whether OK/NG of individual data is displayed or not (If used, also check to use in TOP setting.) 

 

Send All   

- When set to ON, communication is arranged including the maximum group data of ML Series. 

- When set to OFF, communication is arranged including only group data displayed on the screen. 

There is a difference in Group Address according to whether it is used or not. Remark Group Address 

 

Commands 

- Commands = ON fixed (When set to OFF, TOP communication diagnosis and command address is not 

available. ) 

- Use Device ID = OFF fixed ( When set to OFF, TOP communication diagnosis and command address is not 

available. ) 

 

  

  

Transmission status 

Communication speed 

Initial reading 

Example 

Secondary reading 

Data format 

Select "Send All" data 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “DONGDO TECH ML Series”. 

 

 

TOP 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RD 2 2 RD 

SD 3 3 SD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9  

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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6. Supportedaddress 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

POS address Bit Word Size (Bit) Read/Write Remarks 

POS1_START_NUMBER - POS1_START_NUMBER 16 Read  

POS1_OK/NG POS1_OK/NG.0 ~ POS1_OK/NG.1 POS1_OK/NG 16 Read *Note 1) 

POS1_DATA_NUMBER - POS1_DATA_NUMBER 16 Read  

POS1_MODEL_NUMBER - POS1_MODEL_NUMBER 16 Read  

POS1_MODEL_NAME - POS1_MODEL_NAME 16 Read *Note 2) 
 

     

POS2_START_NUMBER - POS2_START_NUMBER 16 Read  

POS2_OK/NG POS2_OK/NG.0 ~ POS2_OK/NG.1 POS2_OK/NG 16 Read *Note 1) 

POS2_DATA_NUMBER - POS2_DATA_NUMBER 16 Read  

POS2_MODEL_NUMBER - POS2_MODEL_NUMBER 16 Read  

POS2_MODEL_NAME - POS2_MODEL_NAME 16 Read *Note 2) 

*Note 1)  

When bit address is used, the result judged to OK = POS_OK/NG.0 NG = POS_OK/NG.1 address is set. 

Ex) When judging OK, POS_OK/NG.0 = 1, POS_OK/NG.1 = 0 

   When judging NG, POS_OK/NG.0 = 0, POS_OK/NG.1 = 1 

When word address is used, OK = 1, NG = 2 is output to the address. 

Ex) When OK is judged, data 1 is output to POS_OK/NG address. 

   When NG is judged, data 2 is output to POS_OK/NG address. 

 

*Note 2) MODEL NAME data is string.   

 

               n= 1~8 

Group address Bit Word Size (Bit) Read/Write Remarks 

GROUP[n]_DATA 
- 

GROUP[n]_DATA 
32 Read 

*Note 

*Note 2) 

GROUP[n]_OK/NG GROUP[n]_OK/NG.0 ~ GROUP[n]_OK/NG.1 
GROUP[n]_OK/NG 16 Read 

*Note 1) 

*Note 3) 

*Note 1) Remark Group Address  

 

*Note 2) 

As Group Data value has a decimal point and a sign, set the data type to DEC, and set the decimal pont length to be the same as that of ML Series in use. 

Ex) If Group Data of ML Series = + 0.001, set the data type of GROUP[n]_DATA address object to DEC, decimal point length to 3. 

If the data type is set to a type other than DEC, the correct measurement value is not output. 

 

*Note 3)  

When bit address is used, the result judged to OK = GROUP[n]_OK/NG.0 NG = GROUP[n]_OK/NG.1 address is set. 

Ex) When judging OK, GROUP[n]_OK/NG.0 = 1, GROUP[n]_OK/NG.1 = 0 

   Ex) When judging NG, GROUP[n]_OK/NG.0 = 0, GROUP[n]_OK/NG.1 = 1 

When word address is used, OK = 1, NG = 2 is output to the address. 

Ex) When OK is judged, data 1 is output to GROUP[n]_OK/NG address. 

   When NG is judged, data 2 is output to GROUP[n]_OK/NG address. 

 

COMMAND address Description Bit Word Read/Write Remarks 

RESET Reset the measurement screen. RESET RESET Write How to use Command 

MCLEAR Cancel the zero point. MCLEAR MCLEAR Write How to use Command 

MZERO Zero setting MZERO MZERO Write How to use Command 
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※ Group Address 

 

As for the Group Address, the output address varies according to the group setting of the ML Series in use. 

It is mapped in alphabetical order of the group being used in ML Serial in TOP Group Address. 

 

When ML Series has 8 groups from A to H,  

Ex) Group Use setting 

A = ON 

B = OFF 

C = OFF 

D = ON 

E = OFF 

F = ON 

G = ON 

H = OFF 

 

 

 

 

 

 

 

 

 

 

If group addresses more than groups being used in ML Series are registered on the TOP screen, an error occurs.  

In the above case, an error occurs when the address higher than GROUP5 is registered. 

 

※ When Send All = ON is set in the Serial setting 

 

 

 

 

 

 

 

 

 

 

When Send All = ON is set, no error occurs even though group addresses more than Groups being used in ML Series is registered on the TOP screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ML Series Group (Setting) Mapping TOP Group Address 

Group A (ON)  GROUP1_DATA, GROUP1_OKNG 

Group B (OFF) GROUP2_DATA, GROUP2_OKNG 

Group C (OFF) GROUP3_DATA, GROUP3_OKNG 

Group D (ON) GROUP4_DATA, GROUP4_OKNG 

Group E (OFF)  

Group F (ON)  

Group G (ON)  

Group H (OFF)  

ML Series Group (setting) Mapping TOP Group Address 

Group A (ON)  GROUP1_DATA, GROUP1_OKNG 

Group B (OFF) GROUP2_DATA, GROUP2_OKNG 

Group C (OFF) GROUP3_DATA, GROUP3_OKNG 

Group D (ON) GROUP4_DATA, GROUP4_OKNG 

Group E (OFF) GROUP5_DATA, GROUP5_OKNG 

Group F (ON) GROUP6_DATA, GROUP6_OKNG 

Group G (ON) GROUP7_DATA, GROUP7_OKNG 

Group H (OFF) GROUP8_DATA, GROUP8_OKNG 
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Ex) Group Use setting 

A = ON 

B = ON 

C = ON 

D = ON 

E = OFF 

F = OFF 

G = OFF 

H = OFF 

 

 

 

 

 

 

 

 

 

 

If group addresses more than groups being used in ML Series are registered on the TOP screen, an error occurs.  

In the above case, an error occurs when the address higher than GROUP5 is registered. 

 

※ When Send All = ON is set in the Serial setting 

 

 

 

 

 

 

 

 

 

 

When Send All = ON is set, no error occurs even though group addresses more than Groups being used in ML Series is registered on the TOP screen. 

 

  

ML Series Group (setting) Mapping TOP Group Address 

Group A (ON)  GROUP1_DATA, GROUP1_OKNG 

Group B (ON) GROUP2_DATA, GROUP2_OKNG 

Group C (ON) GROUP3_DATA, GROUP3_OKNG 

Group D (ON) GROUP4_DATA, GROUP4_OKNG 

Group E (OFF)  

Group F (OFF)  

Group G (OFF)  

Group H (OFF)  

ML Series Group (setting) Mapping TOP Group Address 

Group A (ON)  GROUP1_DATA, GROUP1_OKNG 

Group B (ON) GROUP2_DATA, GROUP2_OKNG 

Group C (ON) GROUP3_DATA, GROUP3_OKNG 

Group D (ON) GROUP4_DATA, GROUP4_OKNG 

Group E (OFF) GROUP5_DATA, GROUP5_OKNG 

Group F (OFF) GROUP6_DATA, GROUP6_OKNG 

Group G (OFF) GROUP7_DATA, GROUP7_OKNG 

Group H (OFF) GROUP8_DATA, GROUP8_OKNG 
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※ How to use the Command address 

The Command address is write-only and can be used by turning the bit of the corresponding address ON or OFF, or registering to 

enter an arbitrary value for the operation of the object. 

 

Ex) Send Command [Reset] command by touching a square object.  

1. After registering the square object, set “Condition” in “Effects and Actions” to [Event > Touch down]. 

2. Set the action to [Bit > RESET address input > ON]. 

  (Set the maximum number of runs to 1, set the cycle, and set the delay to zero.) 

3. When touching a squre object, send COMMAND RESET to connected ML Series. 

 

 

 

 

 


